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Introduction  
What is BEST? 
BEST or the Bioaccumulation Evaluation Screening Tool is one of three models that compose the 
Bioaccumulation Risk Assessment Modeling System (BRAMS), a stand-alone tool for calculating the 
potential risk to human and ecological health associated with bioaccumulative contaminants in dredged 
sediments.  BEST uses 28-day bioaccumulation laboratory data, along with inputs that characterize 
dredge site environment, indicator species, and attributes of chemicals that contaminate the sediments 
in question, to provide health- and ecologically-protective information about risk.   

BEST estimates expected risks to human receptors by (1) calculating the edible tissue concentration in 
human diet species including invertebrate test organisms and their predators based on results of 28-day 
bioaccumulation testing, (2) calculating an average daily dose to humans that consume these species, 
and (3) using USEPA and USACE risk assessment guidance to determine potential carcinogenic and non-
carcinogenic risks (USEPA, 1989a; 1997; USEPA/USACE, 1998; Cura et al., 1999). The BEST reports display 
risk results for dredged sediments compared side-by-side with reference site risks, and acceptable risk 
thresholds. Calculated tissue concentrations are also compared to regulatory thresholds.   

Background 
The US Environmental Protection Agency (EPA) and the US Army Corps of Engineers (USACE) share 
responsibility for the regulation of dredged material, including its disposal. Open-water disposal, a 
common method for discarding of dredged material, can potentially expose aquatic biota and humans 
to health risks if the material being discharged originates from a contaminated site.  Harbors and near-
coast waterways accumulate sediment and chemicals from the contributing landscape, including nearby, 
often urban, terrain and receive effluent directly from industry.  The Marine Protection Research and 
Sanctuaries Act (MPRSA) requires that sediment toxicity be evaluated to determine suitability for open-
water disposal, the protocol for which is outlined in the Ocean and Inland Testing Manuals, commonly 
referred to as the “Green Book” (OTM; ITM) (EPA/USACE, 1991; 1998). USEPA, 1989a; 1997; 
USEPA/USACE, 1998; Cura et al., 1999 

The agencies engage in a “tiered approach” for the evaluation of potential environmental impacts of 
dredged material, to achieve the appropriate level of investigation required for a determination.  BEST 
and the other BRAMS models are designed to support the consideration of environmental impacts, 
particularly from bioaccumulation of contaminants in dredged material, by modeling risk based on Tier 
III benthic-bioaccumulation test data.  Generally, risks posed to human and ecological health by 
bioaccumulative chemicals associated with dredged materials must not exceed those associated with 
reference sediments, or ones that reflect the conditions of the disposal site.  This level of consideration 
is required if contaminants of concern do not exceed federally established limits, which are toxicological 
measures indicative of a contaminant’s potential for adverse effects to human and ecological receptors, 
or if no standard exists.   

Since 1999, EPA Region 1 has evaluated bioaccumulation potential using a screening tool that considers 
whether contaminants accumulated in invertebrates following lab-exposure to dredge material samples 
might result in a risk to human or ecological receptors by direct or indirect consumption (Battelle, 2005). 
EPA Region 1 uses 28-day bioaccumulation test data and a human exposure pathway to model the risk 
of adverse impacts which may occur due to the presence of bioaccumulative contaminates in the 
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material proposed for disposal.  Two invertebrate species, Macoma nasuta (Bent-nose clam) and Nereis 
virens (Sandworm), are exposed to sampled substrate from the proposed dredge site for 28 days, and 
the resulting tissue concentration of various chemicals is determined.  The same procedure is conducted 
using sediment from the designated reference location.  A series of equations, along with the properties 
of the exposure pathway, are then used to model the transfer of contaminants present in the lab 
specimens through trophic levels.  Properties of the chemicals (e.g. oral cancer slope factor and oral 
reference dose) are used to estimate potential cancer and non-cancer risks. 

The BRAMS program, initially released in 2012, includes BEST, a fully customizable model that is based 
on the 1999 EPA Region 1 bioaccumulation risk assessment model framework.  Recent improvements 
(2016-2018) have been made to ensure that BEST can reproduce the EPA Region 1 methodology, 
streamline the model operation for easy and efficient dredged material screening, and enhance 
flexibility so that the model can be applied in other EPA regions. BEST can now also be downloaded as a 
stand-alone tool.  

Getting Started 
Installation and Start Up  
BRAMS is a portable application that does not have to be installed on a hard drive.  Instead it is 
distributed as a stand-alone Java Archive (.jar), which contains an executable java program that is simply 
run.  

Download BRAMS from http://el.erdc.usace.army.mil/trophictrace/ and specify where to save the 
compressed folder. Use a file extractor to unzip the folder, keeping the contents together.  

System Requirements 
Central processor Intel Pentium 1GHz or better 

Operational memory 512 MB or more 
Free space on hard disk  20MB 

Operating system Windows XP/Vista/7/10, macOS or Linux 
Third-party software Java Runtime Environment (JRE) Version 8  or later 

 

Contents of download: 

 BRAMS software 
 Sample chemical list and 28-day bioaccumulation results Excel files to demonstrate the 

necessary formats for import into BEST  
 Template: A .best file that is populated with EPA Region 1 model items, specifications, and 

chemical list.  

To open BRAMS, select BRAMS Program → Bin → BRAMS.jar. Double clicking the file, BRAMS.jar, will 
open the program. 

If it is the first time opening the software on a computer, a User Identification window will appear, 
prompting the user to enter their name before continuing to the main window.  User name will appear 
at the end of reports generated by this software, along with date of use, and software version.   
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User Name can be changed by navigating to File → Change User. 

What you will need to use BEST 
Generally, before the model can be run, 1) the properties of the risk pathway need to be defined and 2) 
the user must add the laboratory results, which report the concentrations of chemicals that will be 
modeled along those pathways.  The user can create entirely new models based on different trophic 
structures, human and ecological exposure scenarios and site-specific conditions or use an established 
template model.  Existing templates are packaged with the BRAMS download. 

BEST requires the following information to estimate risk to humans associated with contaminated 
sediment.  See “Information for Running BEST for EPA Region 1” section for an example of BEST inputs.  

BEST Model Inputs 
 
Properties of invertebrates that are exposed to sediment samples 
         Lipid content of each invertebrate species (g lipid/g tissue) 
         28-Day Bioaccumulation Results  

Properties of 2nd trophic level; predators 
         Lipid content of each predator species (g lipid/g tissue) 
         Predator diet (list of invertebrates) 

Properties of humans and their exposure via diet species 
         Body weight (kg) 
         Lifetime (years) 
         Human diet species and for each, Fraction ingested, Frequency of ingestion (days/year),    
                 Ingested quantity (kg/day), Exposure duration (years) 

Properties of Chemicals potentially detected in sediment  
         Name 
         Type (organic or metal) 
         Cancer slope factor (1/mg/kg-day) 
         Oral Reference dose (mg/kg-day) 
         Steady state correction factor 
         Biomagnification factor 
         Human toxicity equivalence factor 
         FDA Action Level (for organics) or FDA Level of Concern (for metals) (ppm) 
         Ecological Effects Level (ppm) 

User Preferences/Choices 
         Use of mean vs maximum concentration values from lab results 
         Risk thresholds 
         Assignment of reference location 
         Daily dose settings 
         List of organic chemicals of concern to be used in risk estimates  

 



6 
 

 

Building a BEST Model 
The user can create entirely new models based on different trophic structures, human and ecological 
exposure scenarios and site-specific conditions or use an established template model.  With the 
exception of project site-specific laboratory results, many of the exposure pathway and chemical 
properties remain constant across projects, particularly for those within a single regulatory region.  

BEST templates allow the user to start with all or most of the project components already entered into 
the model (except for certain project specific data), saving time and effort and ensuring consistency 
among related projects.  Additionally, projects can be saved as templates so they can be reused and 
templates can be locked so that values are protected during future use (see section x for how to). 

The following sections step the user through creating a new project without a template first, and then 
with a template.  Once the necessary items are in the model and populated with their properties, the 
procedure for setting the final user preferences, adding the laboratory bioaccumulation results and 
selecting which to include, and running the model are the same for a project with or without a template.    
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Build a BEST Model from Scratch 
Create a new project 
From the main window select File → New Project → New BEST Project from the Menu bar or click  in 
the toolbar. Then select “Yes” when the Create new project window appears. 

The new project interface will consist of four panels: 

1) Explorer is used to navigate among the model components 
2) Table displays the model component properties in tabular form and is where the user can add 

or delete from lists of items 
3) Properties panel contains the cells where property values can be edited 
4) Notes provides a space where the user can make notes about the project and document 

decisions, for example 
 
Additional panels can be brought into view using View → Panels: 
 

5) Graph can be refreshed to prompt the program to draw the food chain, as the user has defined 
it the program 

6) Map & Layer a visualization option. ESRI or similar GIS file formats (.shp) can be added to show 
the location of the study and sample sites. The bioaccumulation data can be linked to points or 
areas on the map for ease of use, but the map panel does not generate any additional data (e.g. 
calculate area).  
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Add and edit items and item properties 
In a new, blank project, the user will need to add invertebrates that were tested in the laboratory with 
project sediment samples; predators through which human exposure to chemicals is mediated; human 
populations for which risk associated with exposure will be estimated.  

Each of the following categories of model inputs must have “items” and their corresponding property 
values added manually into BEST with the exception of Chemicals, which can alternatively be imported 
from an Excel file along with their properties.   

The user adds “items” to each category of model components in the Table panel and then specifies 
property values for each in the Properties pane. Because some value choices depend on other inputs, 
add property values to items in each category in the Properties Pane in the order: 

1. Chemicals (see Importing a Chemical List and Properties on how to import a chemical list) 
2. Invertebrates  
3. Predators  
4. Humans 
5. Location 
 
Add items: 

In the Explorer pane, select the item category you wish to add to (e.g. predators) then click  in the 
Table pane to add a new item to that category. A new item will appear in the Explorer pane under the 
selected category and in the Table pane.  Information for the new item is specified in the Properties 
pane.     

Edit items: 

In the Explorer pane, select an item category (e.g., predators). In the Table pane, select the specific item 
(e.g., predator #1) and type the appropriate name (e.g., fish fillet).  Then in the Properties pane, edit 
properties.  A description for each type of input is provided below. 

Item property descriptions: 
 
Chemicals*  
Properties of chemicals that may be present in sediment** 
         Name of chemical 
         Chemical type (organic or metal) 
         Cancer slope factor (mg/kg-day) 
         Reference dose (mg/kg-day) 
         Biomagnification factor 
         Human toxicity equivalence factor  
         Steady state correction factor 
         FDA Action Level (ppm) 
         FDA Level of Concern (ppm) 
         Ecological Effect Level (ppm) 
         TEF Reference and relationship 
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*Importing a chemical list that has been generated in Excel is more convenient and efficient than     
    adding each chemical directly into BEST. 
**If the value of any property is unknown, enter NA in the text box. 

Invertebrates* 
Properties of invertebrates that are exposed to sediment samples 
         Name of invertebrate 
         Lipid content of invertebrate species (g lipid/g tissue) 

*Bioaccumulation test results for each invertebrate will be imported later and will appear here 

Predators 
Properties of predators that are exposed to invertebrates and, in turn, are in the human 
diet 
     Name of predator 
     Lipid content of each predator species (g lipid/g tissue) 
     Predator diet  
 Click  to display a drop down window where you can add the prey 

(invertebrates) of the human diet predators. Click  in the bottom right 
corner of the drop down window to add a new prey species. Then click  to 
the right of the new row to specify which of the existing Invertebrate species to 
add.  Note that the drop down arrow isn't visible until you click the area where 
the new row should be created. 

 

Humans 
Properties of humans that are exposed to predators via their diet 
     Name of human 
     Body weight (kg) 
     Life time (years) 
     Predator diet  
 Click  to display a drop down table where you can add species that make 

up the selected human’s diet. Click  in the bottom right corner of the 
table to add a new row. Then click  below the Prey column in the new row 
to choose from the existing lower trophic level species*. Double click the 
space below each and enter the appropriate values for each: 
     fraction ingested 
     frequency (days/year) 
     ingestion rate (kg/day) 
     exposure duration (years)  

*Note that the human diet can consist of inverberate species in addition to the predators of the 
invertebrates  

Set Toxicity Equivalent Factors and Relationships 
If you manually add chemicals to BEST, instead of importing them from an Excel file, you may need to 
set Toxicity Equivalent Relationships.  In some instances, chemicals of uncertain or unavailable toxicity 
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are assigned a Toxicity Equivalent Relationship and Factor to indicate toxicity relative to a reference 
chemical of known or characterized toxicity (Battelle, 2005).  For example, Benzo(a)anthracene is 
estimated be 10% (or 0.1) as toxic as its reference chemical Benzo(a)pyrene.  In BEST, a chemical can be 
designated as a TEF Reference Chemical and then specified as the reference in the properties of other 
chemicals.   

Navigate to the chemical section and start by 1) checking the box in the Properties pane next to “TEF 
Reference Chemical” to designate a chemical as such and then 2) select a different chemical in the list 
and assign the reference chemical in the dropdown menu next to “TEF Relationship”.  A value between 0 
and 1 should be entered as the “Human Toxicity Equivalence Factor”.  

 

Import Chemical List and Properties 
A list of chemicals and their properties can be entered manually; however, a much more efficient 
procedure is to import them from an Excel file.  This is convenient because the chemical list will remain 
largely (if not completely) the same from one project to the next.  

The Excel Inputs Templates folder that is packaged with the BRAMS software download has a sample file 
to demonstrate the format.  In order for BEST to correctly import the information, the data must be in 
this format.    

To import a chemical list, click FileImportChemicals then navigate to the Excel file that contains the 
table of chemicals and their properties.   

Note that ‘NA’ will be assigned to properties that either have ‘NA’ or no contents in the corresponding 
Excel cells.  

Also note that, once the list is imported into BEST, if chemical properties that correspond to blank cells 
in Excel appear as ‘0’ instead of ‘NA’, you should delete the imported chemicals, then go to the Excel file 
and use the Excel function ‘Clear Contents’ to make sure cells that appear empty actually are.  Then 



11 
 

import the updated Excel file.  A zero value where ‘NA’ should appear will have an unintended effect on 
the results.  

 

Build a BEST Model from an Existing Template 
Open a template 
From the main window, select File → Open Project or Template or click , and then choose a file from 
the Templates folder in the downloaded BRAMS package or an existing model that you want to use as a 
template.  There is no difference between a project and a template file; both have the extension .best.  
This means that an existing project (that already has bioaccumulation data) can be used to create a new 
project, and then saved under a new name, to preserve the original.  Alternatively, a BEST file can be 
saved without bioaccumulation data so that it exists only as a template.  

Note about locked projects/templates 
Projects/templates can be locked so that property values cannot be edited without a password.  When a 
locked project is opened, a message appears indicating that “Project locked with a password” and 
otherwise editable cells are “grayed out”.  This is an important feature for ensuring consistency across 
projects and generating credible results.  When using a locked project as a template, Bioaccumulation 
Test results should be imported and then save the project under a new name. To lock or unlock a 
project, see Lock and Unlock BEST Model Properties. 

Check and Modify Model Components’ Properties  
Because a template is simply a project that is recycled in order to save effort, the degree to which it is 
already populated with the necessary information can vary.  Refer to the Getting Started section at the 
beginning of the manual to see what information is generally saved in a fully populated BEST model.  
 
Click through and expand the folders in the Explorer window to see what already exists in the template 
(i.e., invertebrates, predators and their diets, humans and their diets, and chemicals and their 
properties). Use the instructions from Build a BEST Model from Scratch with details how to add and edit 
items and item properties.   

User Preferences  
There are a few user preferences that may be saved into a template or might be left blank and need to 
be selected for each individual project.  These are risk thresholds, bioaccumulation test result moments, 
daily dose settings, and groups.   

Set Risk Thresholds 
Enter carcinogenic and non-carcinogenic risk thresholds in the General Project Properties pane by 
clicking inside the corresponding text boxes and entering values. Calculated risk levels exceeding these 
thresholds will be highlighted in red in the Total Risks and Contaminant Specific Risks sections of the 
BEST Summary and EPA reports.   
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Set Bioaccumulation Test Results Moment 
The user can control whether the risk estimates are calculated using the maximum or mean invertebrate 

tissue concentration from the project locations.  To specify which moment the model uses, click  to 
the right of Organics and Metals in the Project Properties pane and select the desired choice.  Note that 
moment can be saved into a project/ template. 

Set Daily Dose 
The user can control whether the non-cancer risk estimates for organics are calculated using Average 
Daily Dose or Lifetime Average Daily Dose.  See the Equations section of this manual for how those 
values differ and which are generally assigned for the different types of reports (EPA vs non-EPA).  To 

specify which of the model uses, click  to the right of Summary Report and EPA Report in the Project 
Properties pane and select the desired choice.   

Set Groups 
BEST has the capability to aggregate results.  The user can designate groups of chemicals as well as items 
in the trophic levels.  The BEST output will then report the sum of results for chemicals or items assigned 
to groups.  This capability is important because, for example, there might be multiple analytes that 
compose a chemical group of interest.  Note that group designations can be saved into a project/ 
template.  

The user can control whether the output reports groups and/or ungrouped results in Options (Tools  
Options).  
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Group Invertebrates, Predators, and Humans 
To indicate that items in a trophic level should be summed for the report, a common name is assigned 
to each.  This is illustrated with an example: 

An analysis uses specifies both lobster hepatopancreas and lobster muscle in the risk pathway due to 
the large difference in lipid concentration in each part of the organism. However, when reporting the 
results, the user only cares about the total risk from consuming lobster. Navigate to the Predators folder 
in the Explorer panel and click on one of the first lobster parts to be summed.  In the Properties panel 
under Grouping, type a name (e.g., Total Lobster) and then do the same in the other lobster part, taking 
care to use exactly the same group name.  The risk summary will now report a risk from Total Lobster 
which is the sum of the risk from the two individual group members. 

 

Group Chemicals 
To indicate that results from particular chemicals should be summed in the report, a chemical is 
designated as the grouping chemical, and then constituent chemicals are assigned to the group.  This is 
illustrated with an example: 
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Total Chlordanes concentration should not exceed a threshold concentration, which is set by FDA.  
However, the laboratory reports the concentration of multiple chlordane species. These effects of these 
species need to be summed so that the total chlordane concentration can be compared to the 
threshold.      

Start by 1) creating a new chemical in the chemical list by clicking  in the Table pane and entering the 
name of the group or 2) select an existing chemical from the list that will be designated as the grouping 
chemical.  Total Chlordanes is an existing chemical in the EPA Region 1 chemical list.  Indicate that this is 
a grouping chemical by checking the box next to Total Chemical in the Properties pane.   

Next, navigate to each of the chemicals that should be assigned to the group and, in the Properties 
pane, choose the appropriate group from the dropdown list next to Group Chemical.   
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28-Day Bioaccumulation Results 
Once you populate the BEST interface with model components or open an already-populated project to 
use as a template, and set user preferences, the next step is to import or add the concentrations of 
chemicals found in invertebrate tissue by the lab.   

Import 28-Day Bioaccumulation Results 
Ideally, the laboratory bioaccumulation results can be imported directly into BEST, avoiding manual 
input or user manipulation of the file.  BEST is designed to read in data from the standard reporting 
format used in EPA Region 1, which is in the form of an Electronic Data Deliverable (EDD), and provided 
by the laboratory that conducts the chemical analysis. The Excel Inputs Templates folder that is 
packaged with the BRAMS software download has a sample file to demonstrate the format.  In order for 
BEST to correctly import the information, the results must be in this format. 

Note: A problem that came up during the development and testing of this version of BEST was 
incomplete data importation if the lab results file has formulas instead of values the cells.  For example 
the lab might use a formula in a cell that reports the sum of other results like Total DDT, Total PCBs, etc. 
If you suspect a problem, double check the EDD to confirm that all data is entered as values. 

In BEST, click FileImportImport Bioaccumulation Results.  The Open Excel window will appear where 
you can select the appropriate Excel file. Once you have selected the desired file, click Open.  

Create missing chemicals and invertebrates 
A dialogue box will ask if you want the “Create missing chemicals and invertebrate”.  If the test results 
file has chemicals and/or invertebrates that do not exist in the BEST template/project you are working 
with, selecting “Yes” will add the names of new chemicals and invertebrates to the project but without 
any of the property fields populated.  If the project is not locked and you have the properties to 
populate the new model components, you can select “Yes”. Otherwise, you should select “No”.   

The window will then close and the data within the selected Excel file will be added to the model.  To 
see the added data, select one of the invertebrate items in the Table pane.  Bioaccumulation Test in the 

Properties pane will have lines that are labeled with sample site/composite names.  Clicking the  sign 
to the far right will open a table that is populated with all the bioaccumulation data for that location.  

Assign Reference Location 
Navigate to the project properties by clicking the highest level folder in the Explorer panel, which should 
have been renamed with the project name when the bioaccumulation results were imported.  In the 
Properties panel, select the reference location for the project from the dropdown list, which is 
populated with all of the locations, as read from the bioaccumulation results lab file. 

Select Chemicals of Concern 
The user can select among the chemicals reported on by the lab to include in the risk estimation.  This is 
important because not all of the chemicals analyzed might be of concern, and different stakeholders 
might define what is of concern differently.  See How to Choose Chemicals of Concern for a detailed 
description of how chemical are select according to the “Regional Implementation Manual for the 
Evaluation of Dredged Material” in New England.  
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A list of which chemicals should be included in the risk estimation must be assigned for each 
invertebrate in each sampling location, except for the reference location.  The list of chemicals used in 
the calculations for the reference location will mirror the list used for sampling location for which the 
reference is serving as the basis for comparison.   

Navigate to the Invertebrate properties by clicking the Invertebrates folder in the Explorer panel.  Select 
an invertebrate and, in the Properties panel, expand the Bioaccumulation Test for the first location by 
first clicking . Check off the chemicals that should be included in the calculation and repeat the 
selection process for each location and then for each location for other invertebrates.  To streamline this 
process, use the check box as shown below to toggle between “select all” and “deselect all.” 

 

Note that the tabular form of the chemical list contains a column called “Calculating” and contains a 
checkbox for each chemical.  These checkboxes do not perform the same function as those located in 
the bioaccumulation results and should not be used to choose the chemicals of concern.   

Default selection of chemicals of concern 
To further assist in selecting chemical of concern, the program can automatically select chemicals 
detected at statistically significant level in the invertebrates. When the bioaccumulation results are 
imported, a dialogue box will ask “Select chemicals based on rules?” The program relies on the qualifiers 
reported in the bioaccumulation results to make these default selections. In the figures below, note that 
the chemicals denoted with an “S” for “significant,” are automatically selected in the imported 
bioaccumulation results. These selections can be overridden by the user simply by clicking on a 
checkbox to remove or add a chemical or by toggling “select all” and “deselect all.”   

Note that a statistical qualifier is not reported for Total PCBs, which means that it cannot be auto-
selected by BEST.  If the user wants Total PCBs to be included in risk calculations, they should manually 
select it in the bioaccumulation test portion of the program.  
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Visualize Model Specifications 
 
Graph food chain 
The graphing function allows the user to visualize the food chain that they have defined, through the 
process of assigning model components to the diets of other components in the risk pathway (i.e., 
invertebrates as diet components of predators and predators as diet components of humans).  Open the 
graph pane (View  → Panels  → Graph).  Use the refresh button in the upper left corner to generate the 
food chain visual.  Note that the user can navigate to the model components by selecting them in the 
visual.   

 

Figure 23: Example food chain summary in BEST. Arrows indicate the consumption. 

 

 

Run the BEST Model 
A BEST model is ready to run if: 

1) The model components are populated and the relationships between them defined.   
2) User preferences are set.  
3) The program has a chemical list and 28-day bioaccumulation results to use in the risk estimate 

calculations. 

Before running the model, be sure to save the file.  If you used another project as a template and would 
like to preserve it for future use, be sure to use the Save As… function.  See Saving, Locking, and Reusing 
BEST Projects for details about other options for saving the file. 

Additionally, the user can identify themselves as such and their name will appear on the report 
generated by BEST.  To do so, go to File  Change User then enter user name and click Continue.  
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Note that a report will automatically appear after a run button is clicked.  In general, the run time is 
quite fast.  However, if for some reason, run time is inordinately slow, reports can be generated without 
re-running calculations.  To navigate to the reports for already-run models, use the Run drop down 
menu and select the appropriate type of report. The BEST model has three options for output reports:   

Full Report   
The full report includes the following sections for each location-invertebrate pair:   

Selected Chemicals – reports which chemicals the user indicated should be included in risk calculations 

Diet Report – reports the cancer risk and the non-cancer risk associated with each human diet species 

Prey Report – reports the cancer risk and the non-cancer risk associated with each prey-predator-
human exposure pathway 

Chemical Report – reports the cancer risk and non-cancer risk associated with each chemical of concern 
via each human diet chain, along with intermediate calculations; edible tissue concentration, average 
daily dose, and lifetime average daily dose 

Summary Report  
The summary report compares risk estimates from sediment sample locations to those of the project 
reference site, both for total risk and contaminant specific risks. The summary report includes the 
following section for each location-invertebrate pair: 

Selected Chemicals – reports which chemicals the user indicated should be included in risk calculations 

Total Carcinogenic and Non-Carcinogenic Risks – reports total cancer risk and non-cancer risks in each 
human diet species for both the test and reference sites 

FDA Action and Ecological Risk Levels – reports the mean tissue concentration and steady state 
corrected mean tissue concentration for chemicals in the current invertebrate, along with three 
thresholds: FDA action level, ecological effect level, and FDA level of concern, for comparison purposes 

Contaminant Specific Carcinogenic and Non-Carcinogenic Risks – reports the cancer and non-cancer 
risks from each individual chemical in each of the human diet species for the test and reference sites 

EPA Region 1 Report  
The EPA Region 1 Report is designed to be easily comparable to the bioaccumulation risk analysis report 
produced by EPA Region 1.  The comparable table from the EPA’s report is in parentheses in the table 
headings for easy reference.   

Selected Chemicals – reports which chemicals the user indicated should be included in risk calculations 

Total Estimated Risks From Organics (see EPA Table Xa) - compares total risk estimates from sediment 
sample locations to those of the project reference site 

Seafood Non-Cancer Risks (see EPA Table 6a, Columns F & G) – reports non-cancer risk from individual 
metal of concern along with reference location results 
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FDA Action Limit/ Tolerance (see EPA Table 3, Columns D & E) – reports the FDA threshold value of 
organics (and mercury) along with the steady state corrected mean tissue concentration in the current 
invertebrate 

Ecological Effect Level - reports the ecological effect threshold of individual chemicals along with the 
steady state corrected mean tissue concentration in the current invertebrate 

FDA Level of Concern - reports the FDA threshold value of metals along with the steady state corrected 
mean tissue concentration in the current invertebrate 

Notes on Reading Reports 

 

1. The Summary Report results for non-cancer risks are calculated using average daily dose whereas the 
EPA Region 1 Report results are calculated using lifetime average daily dose, unless otherwise specified 
by the user (see User Preferences section of this manual).  See Calculations and Equations for formulas.  

2. Risk estimates are only reported on those chemicals that are selected by the user (see Select 
Chemicals of Concern) 

3. The FDA Action and Ecological Effects tables report on any chemical that has a threshold specified in 
the chemical list and appears in the bioaccumulation lab results, regardless of the user selecting it as a 
chemical of concern 

4. If the user specified Carcinogenic and Non-carcinogenic risk thresholds on the General Properties 
Panel, the Summary and EPA reports will highlight any risk that exceeds the threshold. This does not 
apply to the FDA Action and Ecological Effect tables.  

5. Chemical risks for any chemical detected may be very small, but they will not be zero. A “0” value in a 
risk report does not indicate zero risk. Instead, it indicates that some required parameter necessary to 
calculate the risk is missing. Check all of the species and chemical tables to ensure all of the data is 
entered correctly. To hide any zeros in the report, navigate to Tools  Options, and deselect “Show 
Zero Values” 

 

Saving, Locking, and Reusing BEST Projects 
Lock and Unlock BEST Model Properties 
Many BEST model users should base their risk assessment models on templates with established 
property values and should only need to edit the 28-days Bioaccumulation Test Results. To prevent 
users from changing the established values (e.g. Lipid content of N. virens, Oral Cancer Slope Factor of 
DDT), these values can be locked. Property values other than 28 Day Bioaccumulation Results will 
become grayed-out and password protected.  

Lock:  To lock a project, select File  Lock Project. This will display the Password Protection window 
where the user should enter a password and click continue.  
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Unlock: To unlock a project, select File  Unlock Project. This will display the Password Protection 
window where the user should enter the previously set password and click continue.  Property values 
should once again be freely editable.  

Save and Save As 
These features function in the same way as most programs. 

Save Permanently  
The Save Permanently feature allows users to save a project file so that it cannot be overwritten. A 
permanently saved file can be accessed and edited but then must be saved under a different name. This 
feature is designed to preserve templates for future use and finalized projects for future review. 

To save a file permanently, select File  Save permanently. This will display the usual Save Project As…  
window where the user can name and specify a location to save the current project permanently. 

Options 
The user can set preferences for some general settings.  Navigate to Options by clicking the Tools 
dropdown menu at the top of the program interface and selecting Options.   

The most useful control pertains to how information appears in the reports.  The user can indicate by 
selecting the checkboxes whether they want reports to: 

 Show zero values 
 Show group totals 
 Show group details 

*See the User Preferences section of this manual for more information on assigning groups of chemicals 
and items within trophic levels.    

Information for Running BEST for EPA Region 1 
Nearly all of the information in this section is saved into the template that is packaged with the BRAMS 
software download.   

Model Item Details 
Invertebrates   

Species Lipid Content (g lipid/g tissue) 

Macoma nasuta 0.0124 
Nereis virens 0.0146 

 

Predators    

Type Lipid Content (g lipid/g tissue) Diet Invertebrate 

Lobster Hepatopancreas 0.089 Macoma nasuta, Nereis virens 

Lobster Muscle 0.008 Macoma nasuta, Nereis virens 

Fish Fillet 0.003 Macoma nasuta, Nereis virens 
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Note: All predators prey on both clam and worm equally 

Human Population   
Lifetime (years) 70 
Body weight (kg) 70 

 

Human Diet           

Invertebrate Predator 
Fraction 
Ingested 

Frequency 
(days/year) 

Ingestion Rate 
(kg/day) 

Exposure 
Duration   
(years) 

  
Lobster 
Hepatopancreas 1 365 0.006 30 

  Lobster Muscle 1 365 0.03 30 
  Fish Fillet 1 365 0.05 30 
Macoma nasuta   1 365 0.014 30 
Nereis virens   1 365 0.014 30 

 

User Preferences 

Risk Thresholds   
Type Threshold 

Carcinogenic 0.0001 

Non-carcinogenic 1 
 

Invertebrate Tissue Concentration Moments 

Chemical Type Moment 
Organics Maximum  
Metals Mean 

 

Chemical Groups  
Group Constituents 
Total DDT DDT 

DDE 
DDD 

Total Chlordanes cis-Chlordane     
cis-Nonachlor 
Oxychlordane 
trans-Chlordane   
trans-Nonachlor 

Benzo(a)pyrene TEQ Sum Benzo(a)anthracene 
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Benzo(a)pyrene 
Benzo(b)fluoranthene 
Benzo(k)fluoranthene 
Chrysene 
Dibenzo(a,h)anthracene 
Indono(1,2,3-c,d)pyrene 

 

Trophic Groups  
Group Constituents 
Total Lobster Lobster Hepatopancreas 

Lobster Muscle 
 

How to Choose Chemicals of Concern 
Laboratory reports include the statistical significance of results compared to reference sites.  All results 
that are found to be statistically significant are included in the risk assessment.  Note, as previously 
described, that BEST has been updated so that it can auto-select those chemicals that should be 
included, by reading the qualifiers column of the lab results.  Also note that Total PCBs needs to be 
manually selected by the user, as it is not assigned any qualifiers by the lab.  

Calculations and Equations 
EPA Region 1 
Organic Contaminants 
The following procedure is used for each individual chemical that the user chooses to include in the risk 
estimation.  Total Estimated Risk is the sum of the individual risks.  

1) Eq. 1a is used to calculate a steady state corrected invertebrate tissue concentration, or edible 
tissue concentration, using 28-day bioaccumulation test results and chemical properties in the 
following equations for metals and organics respectively. Cprey is the maximum concentration.  

2) Eq. 2 applies a trophic transfer model to predict the chemical concentrations that will result in 
predator species that consume invertebrates 

3) Eq. 3a is used to predict the Lifetime Average Daily Dose (LADD) of contaminants that humans 
could be exposed to.  EPA Region 1 uses LADD to estimate cancer and non-cancer risk.  

4) Finally, Eq 4a is used to determine the carcinogenic risk level, the Lifetime Average Daily Dose 
(LADD) is multiplied by an oral cancer slope factor (CSF).  Eq 4b is used to determine the non-
carcinogenic risk level, is divided by a reference dose (RfD) according to the following equations: 

Metal Contaminants 
Risk via metal is estimated with a somewhat different procedure than organic contaminants.  Seafood 
non-cancer risk, as EPA Region 1 refers to it, is the non-cancer risk to humans posed by consuming 
Macoma nasuta, the bent-nose clam, that are contaminated by metals.  The risk associated with 
individual metals is not summed.  
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1) Eq. 1b is used to calculate a steady state corrected invertebrate tissue concentration, or edible 
tissue concentration, using 28-day bioaccumulation test results and chemical properties in the 
following equations for metals and organics respectively. Cprey is the mean concentration. 

2) Eq. 3a is used to predict the Lifetime Average Daily Dose (LADD) of contaminants that humans 
could be exposed to.  ETC is that of the Macoma nasuta.  

3) Eq. 4b is used to estimate the non-carcinogenic risk level. 

Summary Report 
Organic and Metal Contaminants 
The only difference between the EPA Region 1 procedure for estimating risk and the BEST summary 
report procedure is the human dose equation that is used for non-cancer risk calculations.  For the 
summary report procedure, see the EPA Region 1 section above.  For non-cancer estimates, Eq. 3a 
Lifetime Average Daily Dose is replaced with Eq. 3b Average Daily Dose.  Average Daily Dose is then used 
in Eq. 4c which estimates non-cancer risk.  Note that the user can control which type of averaging time is 
ultimately applied in the calculations.  The equations provided in this manual are prescribed based on 
EPA Region 1 history and a 2005 evaluation of that model by Battelle1.  See Set Daily Dose section of this 
report for instructions.  

Equations 
Invertebrate Edible Tissue Concentration 

Organics 

(1a) [Edible Tissue Invertebrate, Organic] (mg/kg) = [𝑪𝒑𝒓𝒆𝒚] 𝒙 𝑺𝑺𝑪𝑭

𝟏𝟎𝟎𝟎
         

Where:  

[Cprey] = mean or maximum (chosen by user, see Set Bioaccumulation Test Results Moment) 
tissue concentration from the 28-day bioaccumulation test data (ng/g) 

SSCF = steady state correction factor (unitless) 

[Edible Tissue Invertebrate, Organic] = Concentration of organic contaminant in edible tissue of 
invertebrate species (mg/kg) 

 

Metals 

(1b) [Edible Tissue Invertebrate, Metal] (mg/kg) = [Cprey] x SSCF 

Where:  

[Edible Tissue Invertebrate, Metal] = Concentration of metal contaminant in edible tissue of 
invertebrate species (µg/g) 

                                                           
1 The Battelle (2005) report recommends that EPA model change from LADD to ADD for non-cancer risk.  As of this 
date (2018), the risk calculations have not been updated.   
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 [Cprey] = concentration of contaminant in the invertebrate in the maximum replicate of five 
replicates from the 28-day bioaccumulation test data depending on the user’s choice (µg/g) 

SSCF = steady state correction factor (unitless) 
 

Predator Edible Tissue Concentration 

 (2) [EdibleTissuePredator] (mg/kg) =  [ 𝐄𝐝𝐢𝐛𝐥𝐞 𝐓𝐢𝐬𝐬𝐮𝐞𝐈𝐧𝐯𝐞𝐫𝐭𝐞𝐛𝐫𝐚𝐭𝐞] × 𝐁𝐌𝐅 × ൬ 
𝐋𝐢𝐩𝐢𝐝𝐏𝐫𝐞𝐝

𝐋𝐢𝐩𝐢𝐝𝐏𝐫𝐞𝐲
൰   

Where:  

[EdibleTissueInvertebrate] = Concentration of contaminant in edible tissue of invertebrate prey 
species from equation 1 (mg/kg) 

BMF = biomagnification factor (unitless) 

LipidPred = predator mean lipid fraction (g lipid/g tissue) 

LipidPrey = invertebrate mean lipid fraction (g lipid/g tissue) 

[EdibleTissuePredator] = Concentration of contaminant in edible tissue of predator (mg/kg) 

 
Dose to Humans 

 (3a) Lifetime Average Daily Dose (mg/kg-day) = 𝑬𝑻𝑪 𝒙 𝑭𝑰 𝒙 𝑭 𝒙 𝑰𝑹 𝒙 𝑬𝑫

𝑩𝑾 𝒙 𝑳𝑻𝒙 𝟑𝟔𝟓
 

 

(3b) Average Daily Dose (mg/kg-day) = 𝑬𝑻𝑪 𝒙 𝑭𝑰 𝒙 𝑭 𝒙 𝑰𝑹 𝒙 𝑬𝑫

𝑩𝑾 𝒙 𝑬𝑫 𝒙 𝟑𝟔𝟓
 

Where:  

ETC = Edible Tissue Concentration of human diet species (mg/kg) either [EdibleTissuePredator]  
from equation 2 or [EdibleTissueInvertebrate] from equation 1. 

FI = Fraction Ingested (unitless) 

F = Frequency (days/year) 

IR = Diet Ingestion Rate (kg/day) 

ED = Exposure Duration (yrs) 

BW = Body Weight (kg) 

LT = Lifetime (yrs) 

365 = Conversion factor of exposure duration to days 

LADD = Lifetime Average Daily Dose 
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Cancer and Non-cancer Risks 

(4a)     Cancer Risk = LADD x CSF 

(4b)    EPA Non-cancer Risk = LADD/RfD 

(4c)    Non-cancer Risk = ADD/RfD 

Where:  

 LADD = Lifetime Average Daily Dose (mg/kg-day)  

CSF = Oral Cancer Slope Factor (mg/kg) 

 RfD = Oral Reference Dose (mg/kg) 

 ADD = Average Daily Dose (mg/kg-day) 

  

Glossary 
Trophic Transfer 
The BEST risk model predicts edible tissue concentrations in predator species by applying a trophic 
transfer model to the measured concentrations in invertebrate test species (Equation 1) based on the 
results of the 28-day bioaccumulation testing. This approach assumes that the test species represent the 
prey species typically consumed by predators, and that 100 percent of the organisms consumed are 
exposed to the dredged material. 

Steady State Correction Factor 
A steady state correction factor (SSCF) is used to correct for underestimates of prey tissue 
concentrations in standard 28-day bioaccumulation testing. Because the standard testing period (28 
days) might not be long enough for the exposed organisms to reach a state of equilibrium with their 
environment, the SSCF is applied to further estimate prey tissue concentrations under natural exposure 
periods that are longer than the standard testing duration.  

Biomagnification Factor 
The biomagnification factor (BMF) accounts for accumulation of chemicals in predator tissues from 
consumption of invertebrate prey. Chemicals that biomagnify, or increase concentration up the food 
chain, will have BMFs >1 while those that do no biomagnify will have BMFs ≤ 1. 

Risk 
The BEST model estimates the carcinogenic and non-carcinogenic risk to human health based on the 
consumption of species directly exposed to contaminants in the sediment and their predators using 
standard risk equations (EPA, 1989b) based on the lifetime average daily dose (LADD) and average daily 
dose (ADD), respectively.  

Cancer slope factor (mg/kg-day)  
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The slope factor is the cancer risk (proportion affected) per unit of dose 

Reference dose (mg/kg-day) 
The oral reference dose (RfD) is an estimate of a daily exposure to the human population that is likely to 
be without an appreciable risk of deleterious effects during a lifetime 

Human toxicity equivalence factor 
The toxicity equivalency factor (TEF) methodology was developed by the U.S. Environmental Protection 
Agency (EPA) to evaluate the toxicity and assess the risks of a mixture of structurally related chemicals 
with a common mechanism of action. A TEF is an estimate of the relative toxicity of a chemical 
compared to a reference chemical. 

FDA Action Level (ppm) 
Used to determine whether regulatory action is indicated for organics. Level of Concern is based on 
non-cancer endpoints, such as cardiovascular and dermatological effects, that could occur with 
consumption of higher levels of the target chemical over a limited period of time (short term, not 
lifetime) 

FDA Level of Concern (ppm)  
Used to determine whether regulatory action is indicated for metals. Level of Concern is based on 
non-cancer endpoints, such as cardiovascular and dermatological effects, that could occur with 
consumption of higher levels of metals over a limited period of time (short term, not lifetime) 

Ecological Effect Level (ppm) 
Threshold indicating potential effects of chemicals and other pollutants on ecological communities 
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